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Why Customers Are Migrating?

Business: Technical:

Vendor Issues Product Issues
Business Practices Ongoing Enhancements
Pricing Issues Integration With Other
Upgrade Fees Products And Hardware
Rising Maintenance Fees Enhancements
Unplanned budget overages Product Support
Long Term Contracts Administrative Complexity

Application Development Environment
Unable to deploy new applications on the platform
that best meets business needs (S/390)

Forced to consider other platforms for application
hosting or affordable tools and utilities

Reuse traditional assets in the Internet world

Demand for more sophisticated tools to develop and
deploy e-business runtime like WebSphere & MQ

'ON DEMAND BUSINESS
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IBM’s Solution

= Offer a set of tools that:
» Exploits IBM'’s latest software and processor technology
» Offer wide array of key features and functions
» Can enhance the Application Development Lifecycle
» Provide opportunity for increased user productivity
» Are affordably priced
» Have flexible terms and conditions
» Have no license keys
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Switching from Compuware to IBM

Abend-AID/XLS

Abend-AID-IMS
CICS Abend-AID/FX
CICS Abend-AID/FX for DB2 /
/ DB2 1

Abend-AlD/e-Business
File-AID/MVS
File-AID/DB2

File-AID/IMS
Debug Tool U

XPEDITER/CICS and Advanced Functions

XPEDITER/TSO / Application Time Facility
XPEDITER/IMS

XPEDITER/DB2 Workload Simulator
XPEDITER/Code Coverage

XPEDITER/XChange

QA Hiperstation ‘
Strobe Suite (CICS, DB2, IMS, COBOL) /|
M w=mea ¢ e ON [DEMAND BUSINESS

COBOL
Modernization

ities

Application Performance Analyzer
Application Performance Analyzer
Automation Assistant
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z/OS Problem Determination and Deployment Tools

Fault Analyzer for z/OS

» Captures and analyzes abend information about application and
environment

File Manager for z/0OS

» Manages production, test, and development data across multiple file
formats and storage media

Debug Tool Utilities and Advanced Functions for z/OS
» Interactive source level debugging for multiple languages

Application Performance Analyzer for z/0OS
» Helps maximize application performance

= Application Performance Analyzer Automation Assistant for
z/0S

» Provides automation and integration of Application Performance Analyzer
and its reports

MAND BUSINESS
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z/OS Problem Determination and Deployment Tools

= Workload Simulator for z/OS and 0S/390
» Regression, performance, stress, function, and capacity testing

Migration Utility

» Replaces CA-Easytrieve Plus® run-time and development tools with
standard IBM COBOL programs

Application Time Facility
» Provides date and time manipulation for time sensitive applications

ISPF Productivity Tool

» Integrates with ISPF providing improved access to key functionality,
reducing time-consuming navigation steps

Rational Developer for System z

» Rational® Developer speeds efficiency of traditional mainframe, Web
development and integrated mixed workload

MAND BUSINESS
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Fault Analyzer - Helps you rapidly pinpoint why and where an
enterprise application failed - and offers suggestions on how to
resolve

BATCH I Ims CICS PDBE2 I M@Series

Fault
Analyzer

ISPF/CICS
RDz/Web
| 4 _ |

'ON DEMAND BUSINESS

Abend
Diagnosis
Analysis Reports

-~
\ 4

Single fault
analysis
product for all
environments

Provide data to to
help determine
WHY, WHERE, HOW
the failure occurred
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Fault Analyzer Features

Analysis at application level

Information gathered at time of
abend

Translates low-level dump
information into application-level
information

Expands abend code and
message descriptions

No recompile of applications

No JCL changes

No performance overhead
Integrated 64-bit DB2 support
Interface to File Manager for z/OS

= Modes Of Operation
» Real-time analysis
» Batch dump re-analysis
» Interactive dump re-analysis

= |nterfaces
» ISPF
» CICS
» RDz
» Web

= Support for IBM software
» CICS TS 3.2

= Channels and containers in 64-
bit storage

= Containers with XML data
» DB2 V9
» IMS V10

MAND BUSINESS
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File Manager -
data file structures

Manage a variety of enterprise

|

Common User
Interface In All
Environments

F|Ie File
Manager Manager
z/0S CICS

£
|
A

Do what you want,
SP::DCZ'CS how you want,
with your data

1 %
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File Manager z/OS Features
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Full function edit and view

» Table

» Single

Flexible selection criteria

» Work with copybooks or templates
Edit any file regardless of size
Create data

Print data

Copy data

» File reformatting
» Scramble fields
Catalog services

Work with VTOC

Compare
» Data
» Load Modules

Search for and change data

» Insert continuation JCL
statement

View or print
» Copybooks
» Templates

Modes Of Operation
» Interactive

» Batch

Interfaces

» ISPF

» CICS

» RDz

'ON DEMAND BUSINESS'
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File Manager CICS Features

= |ISPF-like panels = Support for extended
= Full function edit and view addressability ESDSs
» Table = Interface to File Manager z/OS
» Single = Interface to File Manager IMS
= Flexible selection criteria = Modes Of Operation
» Work with copybooks or templates » Interactive
= CICS Resource = Interfaces
» File » CICS
» Temporary Storage = Support for IBM Software
» Transient Data » CICS TS V3.2
= Print data

List Resources

'ON DEMAND BUSINESS
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File Manager DB2 Features

Edit and View data
» Edit a DB2 Table or View
» select rows and columns displayed

Print
» Table or Single format
» select rows and columns

Create and Drop DB2 objects

Copy data
» Select rows

» Map columns from an input table to an
output table

» Reformat and generate data while
copying

» Scramble columns

Work with a list of DB2 objects

» Use line commands to initiate functions

Generate JCL for DB2 utilities:

» COPY, LOAD, REBUILD, RECOVER,
REORG, and RUNSTATS

Relational Edit

Grant and Revoke DB2 privileges

Import and Export data
» Select Rows

» Export to a file in default FM/DB2 format,
a format defined by a copybook, or a
comma-delimited file

» Import from a file generated by the Export
function, or a file described by a copybook

» Scramble columns
Execute SQL Statements

Create and test new SQL statements
» Two methods: Basic and Advanced
Modes of Operation

» Interactive

» Batch

Interfaces
» ISPF

Support for IBM software
» DB2 V9

MAND BUSINESS
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File Manager IMS Features

Online utilities for IMS databases
» Edit and Browse data

» Extract segments from a database
» Load segments into a database
Support for processing databases using
either:

» physical DBD

» logical DBD

Access databases using either:

» Static (existing) PSBs

» Dynamic PSBs

Process databases in alternate sequences
using secondary indexes

Support for HDAM, HIDAM, HISAM, HSAM,
DEDB. MSDB

Optional audit trail to record database
updates

Work with segments that have multiple
layouts

Optionally use COBOL or PL/I segment
layouts to format data into fields

» Edit and Browse segments in tabular or
character format

» Access source in PDS, PDSE, or Panvalet
libraries

Use flexible criteria to select segments for
browse, edit, and extract processing

Change segment selection criteria and
formatting “on the fly”, while browsing or
editing

Modes of Operation

» Interactive

» Batch

Interfaces
» ISPF
» CICS

Support for IBM Software
» IMS V10

DEMAND BUSINESS'




| IBM Software Group

Debug Utilities and Advanced Functions — Debugging
of enterprise applications to isolate coding issues

Code
D_ebt_:g _ Coverage
application in Utility

supported
environment

oad Module
Common user Analyzer Utility
interface across COBOL
systems and Modernization

subsystems Utility
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Debug Tool Utilities and Advanced Functions Features

= Source-level debugging

= Multiple breakpoints
» Conditional
» Unconditional

= Step mode debugging
= Dynamic patching

» Modify variables

» Insert statements

= Command logging of debugging
session

= Frequency sampler
= Programmable command entry

= Utilizes LE services
» Breakpoints at LE conditions
» Recovery of program abends

= Interactive playback support

Automonitor support for COBOL,
PL/I, and Assembler programs

Save and restore sessions settings
An interface to the Fault Analyzer

Commands to query, allocate, and
free files

Object level disassembly
debugging

CICS

» Detect storage violations

» Memory editor and browser

» Display channel and containers
» Pattern-matching breakpoints

64-bit register support Assembler

MAND BUSINESS
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How do | interface with Debug Tool?

r1 1 Session A - STLMVS1.WS - [24 x 80] =1

coBoL LOCATIAM:
Command ===» Scroll ===» PAGE
M

OOo1 1 OUTPUT-FLAG

000zf 2 H1-CURR-DATE || o0l/05/03'|
0003f 3 GM-MSG-ID JJo1l'|
Doo4)g 4 ACTION |’ !

Batch, CICS,

MOVE FUMCTIOM UPPER-CASE (SCREEM-INPUT) to ACTION. [)E3:2: or IhAES
application

Application

#% End program when EXIT is entered and

= Full-screen mode
» 3270 interface
» Work with Debug Tool from a VTAM terminal
» Common interface for all z/OS runtimes, CICS, JES, IMS TM, DB2 Stored Procedures, etc.

» Debug Tool uses a terminal that you specify... your CICS or TSO terminal can be used

MAND BUSINESS
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How do | interface with Debug Tool?

{5} 1BM WebSphere Developer Debugger for zSeries

File Run - Debug Console Monitors Variables Window Help

} 5 Debug 11 P @ n 2@ ] |[& 7 OB Menitors 53 Bresbpoints | Moddes] — O

=1 [, com.ibm.debug.load [Compiled Application] FRRLEBED L ES
=15 Platform: OS/190(R) Connection: .39.64,151:15% @ RECDAY L 0T

=l Thread:1 (Runnable )
= ATCDEMO: 01
.E Process: 427876576 Program: ATCDEMO

TCP/IP

E e =5
Line 256 owse

Application

Cnlm 50 Insert T
1- B-
L)
MOVE PD-TOOL-DEMO-TYPE TO DEMO-TYPE.
MOVE RECORD-YEAR1 TO RECORD-TYPE1-YEAR.
251
252
253 * COMPARE THE SYSTEM DATE WITH THE INPUT RECORD DATE *
25¢
ol
258 ADD 10 TO RECORD-DAY1 (e Fmjm'sl =g Batch CICS
257 ELSE (= ) ]
ADD 5 TO RECORD-DAY1 E el s I
END-IF. - @ [NPUT-RECORD ='01Dennis Smith e[ D82 Or IMS
[=-® CURRENT-DATE L]
261 @ CURRENT-YEAR =06
262 * COMPARE THE SYSTEM DATE IS LESS THAN THE RECORD DATE * @ CURRENT-MONTH = 01 I' H
263 @ CURRENT-DAY = 17 app |Cat|0n

L33 Debug Console £7 . Memory
Program was stopped due to entry/function breakpoint

1111111111

(<]
Debug Engine Command:

= Websphere Developer Debugger for zSystems (WDDz):

» the host application starts Debug Tool, which connects to a remote debugger on
your workstation

» Point and Click ease of use
» Uses the GUI debug interface built into products such as:
= Eclipsed based Rational Developer for zSystems (RDz)

'ON DEMAND BUSINESS
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How do | interface with Debug Tool?

Command File

\pplicatio

Batch, CICS,
DB2, or IMS
application

= Debug Tool “Batch” Command File mode
» Invoke the application in the background under the control of Debug Tool commands
» Can drive the program to exception conditions and log runtime results for later diagnosis
» For creation of:

= Regression Test cases
= Production Runtime problem diagnosis

'ON 'DEMAND BUSINESS
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Code Coverage Utility Features

= Does not require any updates to the test case runtimes

= Supports any number of testers running multiple executions
Accumulates coverage statics accorss multiple runs
Reports statement coverage

Reports statement frequency

Reports branch execution

Provides 1403 reports for coverage

Generates XML report output for migration

"DEMAND BUSINESS
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Load Module Analyzer Utility Features =j

= Reports compiler versions for all CSECTs that make up a load
module

= Reports compile dates for all CSECTs that make up a load
module

= Can be exectuted interactively from ISPF panels
= Can be submitted to run in batch

= Report display options are configurable:
» Utility report features
» Filter compiler versions reported

» Filter CSECTSs that are part of the LE runtime
» Filter CSECTs that are part of the compiler

|DEMAND BUSINESS
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COBOL Modernization Utility Features

= Supports reporting and converting COBOL
= Converts standard 68 and 74 standard to 85 ha—
» Reviews, reports, and converts COBOL source (including copybooks)

= |dentifies COBOL language elements and CICS commands in the input
source programs that are:

» Not supported by the target language
» Supported in a different manner

= Converts COBOL 74 & 68 elements to the equivalent in the target
language

= Reports identification of source requiring conversion for COBOL 68 & 74 to
COBOL 85

= Converts any COBOL compiler to current version fixing new KEYWORDS,
etc

= Converted Source
» Converted COBOL program source
» Converted COBOL copy files

MAND BUSINESS




| IBM Software Group

Application Performance Analyzer - Provides rapid pinpointing of
enterprise application bottlenecks

@ Series

IS0 User: JAVA

Observation session

REN\Za

Print reports from z/OS | _ Application
b Performance
Analyzer
| bottlenecks
'EI - F [b in
- W

application
code

View reports
View reports in PDF format on PC
online with IS




Application Performance Analyzer Features
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Summary/Profile reports with drill down into detailed levels via an ISPF
interface or PDF hardcopy

CPU, Load Module, and CSECT analysis of all modules in the address
space

Source statement (COBOL or PL1) or instruction utilization in each CSECT
Supports Fault Analyzer / Debug Tool Sidefiles
Wait time analysis by category, task/module, or attribution

DASD I/O analysis by device, DDNAME, dataset and dataset attributes,
EXCP’s, VSAM with buffer pool, 1/0O wait, over time

SYSPLEX coupling facility reports

CICS session statistics, transaction analysis by CPU usage, mean and total
service time, and waits by transaction

MAND BUSINESS
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Application Performance Analyzer Features

DB2 SQL analysis — static and dynamic — service times
DB2 analysis by DBRM, statement, and plan

IMS CPU and service time analysis

MQSeries analysis by queue, request, and transaction
JAVA

Unix System Services support

Performance comparison

Interval reporting

Adjustable sampling rate

Repeated observation sessions

Internal (APA) and external (RACF, etc) security

'ON DEMAND BUSINESS
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Application Performance Analyzer Features

= Types of Observation Sessions
» Real-Time
» Scheduled
» Via batch submission
= Non-intrusive performance analyzer for applications and systems
programmerss to
» Improve response time in online applications
» Improve batch turn around time
» Identify excessive I/O activity
» Identify excessive CPU usage
» Test the effects of increasing workload
» Isolate performance problems in new and existing applications

= Support for IBM Software
» CICS TS V3.2
» DB2 V9
» IMS V10

'ON DEMAND BUSINESS
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Application Performance Analyzer Report Summary

CPU

Usage by Category
Usage by Procedure
Usage by Module
Referred Attribution
Usage by Code Slice
Usage Timeline
Usage Task/Category
Usage Task/Module

MQSeries

Activity Summary

Serv Time by Txn

CPU Usage by Queue
Wait Time by Queue
CPU Usage by Request
Wait Time by Reque
CPU Usage by Txn
Wait Time by Txn

Serv Time by Queue
Serv Time by Request

|UN DEMAND BUSINESS




| Part 1: Introduction

Application Performance Analyzer
Automation Assistant - Provides automation and integration of

Application Performance Analyzer and its reports

TSPF Interface

N '

—

=]

DB2 IMS CICS MQS APA
Extractor Extractor Extractor Extractor Extractor

——

l[: TSPF Interface

'ON DEMAND BUSINESS



| IBM Software Group

Application Performance Analyzer
Automation Assistant Features

= Can eliminate up to 90% of the manual
effort to manage application
performance

= Reduces CPU utilization by definition
of threshold values

= Allows customer to focus tuning efforts
on jobs with the greatest CPU and
runtime savings potential with user-
defined thresholds

= Automatically identifies tuning
opportunities across your entire batch
and online mainframe environment,
including Parallel Sysplex

= Provides measurement resulis that can
be analyzed and stored

= Monitors program changes
= Provides performance history

= Environment and Threshold definitions
(Watchlist)

» Environment: Sysplex and
Subsystem description

» Threshold: To determine the
candidates for a deeper analysis,
two types available:

= Absolute field values (CPU
time, number of /O, ...)

. Relative performance fields
(CPU consumption per second,
l/O per second, ...)

= Include / Exclude Lists
= Filtering candidates in batch

= |SPF Interface

» To retrieve data from the APA AA
DB2 Performance Data Warehouse
and show the candidates on
Watchlists.

MAND BUSINESS
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Workload Simulator - Conducts Reliable Stress, Performance,

Regression, Function And Capacity Planning Tests

z/0S and 0S/390

Applications
under test

VTAM

Workload
Simulator

Projects
Resources
Schedules

Test Criteria
Test Cases

Improve
application
RAS

Plan for growth
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Workload Simulator Features -

—_— -

Auto Generation Of Scripts = Conducts Reliable Stress,
Performance, Regression,

Function And Capacity Planning
Controls Resource During Runs Tests

Auto Generation Of Networks

Simulates Different Terminals,

Terminal Features And Terminal * Consistent Across Protocols

Operator Actions » SNA, CPI-C, TCP/IP
Executes Independently Of The = Consistent Across Operating
System Under Test Systems

Provides utilities for post-test » 2/OS & 0S/390, MVS/ESA, VM/ESA

analysis
REXX-like scripting language

DEMAND BUSINESS'
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Migration Utility - Provides rapid development for adhoc requests

SO User

Single
Migration Utility
Product For All
Environments

Print reports from z/OS

a

Provide
ongoing
program
development
using the
Easytrieve
Plus syntax

View reports
View reports on the Web
online with ISPF

'ON DEMAND BUSINESS
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Migration Utility Features

» Existing and new Easytrieve Plus programs using Easytrieve Plus
language can be processed by the Migration Utility product

= Source code, written in Easytrieve Plus,
= can continue to be maintained

» Programs written using Easytrieve Plus language can be converted to
standard IBM COBOL

» Creates IBM standard COBOL syntax from Easytrieve Plus language
statements without Easytrieve Plus installed

» Discovery Ulility

» Batch Conversion Utility

» Parallel Testing and Electronic Output Comparison Utility

» Enables re-use of existing compiler JCL with only minor changes

» Enables re-use of existing application JCL with only minor changes

MAND BUSINESS
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Migration Utility Features

= Provide automated conversion of Easytrieve Plus programs to COBOL

Provide ongoing program development using the Easytrieve Plus syntax

Provide an affordable high level development tool for COBOL Environment

Provide a tool that will keep up with the changes in hardware technology

Enables User to retain Easytrieve ease of use at a much lower cost
» Lower annual cost
» Possible machine cycle savings at run time

'ON DEMAND BUSINESS
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Application Time Facility — Easy for programmers to specify the

jobs to receive simulated dates

IDMS
IDEAL
Natural

Helps software
development teams
ensure their
software performs

as intended

Application
Time Facility

'ON DEMAND BUSINESS
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Application Time Facility Features

Shifts time zones for on-line regions so users will see their local time or, so
dated application file updates will have the local time

Restarts a failing job at the date/time it failed, ensuring that file update and
reports are not affected

Allows jobs that, due to unavoidable circumstances, run over a deadline to
finish "on time"

Handles all clock formats including decimal, binary, timer units,
microseconds and TOD clock format

On-line ISPF interface makes it easy for programmers to specify the jobs to
receive simulated dates on an individual basis, or as generic groups by
using a wild card

Allows testing of applications that are reliant upon timing, time zones, or
time and date formatting without changing z/Series system date / time
settings

MAND BUSINESS
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ISPF Productivity Tool — Enhances TSO ISPF productivity

ISPF In;:lrgla:?:es the %roduc}(i_vity
- 0 users by packing
Pmduc"v'ty various ISPF functions
Tool into the areas in which
programmers most

frequently work

'ON DEMAND BUSINESS
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ISPF Productivity Tool Features

Consolidates commands within a
single panel

Presents a comprehensive, object-
oriented, project-related list of data
sets

Provides extensive point & shoot
capabilities

Extended TSO command
execution

Automatic PDS compression

Reduces keystrokes and EXCP
counts

Enhanced print and clipboard
capabilities

Improves ISPF navigation

SCLM, Librarian, Panvalet Library
support

IPT increases the productivity of
ISPF users by packing various
ISPF functions into the areas in
which programmers most
frequently work, such as browse,
edit ,member lists, and dataset
lists.

New commands and functions
reduce the need to navigate to
additional panels to perform utility
functions. This results in reduced
keystrokes and increase
productivity.

MAND BUSINESS
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File Export Utility - Flexible solution for exporting and
Importing related sets of enterprise data

Reformat data, scramble
sensitive data, create Nth
selections of data, and.
exploit application
defined data
relationships

File Export
Utility

Extract
related data
from multiple
sources

'ON DEMAND BUSINESS
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File Export Utility Features

Flexible solution for exporting and importing related sets of enterprise data
Provides for one-to-one, one-to-many and many-to-one data creation

Copies all data in a related set of objects or a slice of data across a related set of
objects

Supports application defined relationships

Includes highly flexible data selection and transformation rules

Gives the user the option to protect sensitive data on a field by field basis
Supports altering data content while copying

Includes a repository in which common persistent information about your data is
stored

Offers highly selective data copying capabilities that simplify the complex task of
populating test environments, or migrating applications to new or additional
environments

MAND BUSINESS
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Rational Developer for System z - Accelerates the development
of your Web applications, traditional COBOL and PL/I applications, Web
services and XML-based interfaces.

= (Challenges - Islands of development

Duplicate infrastructures limit IT and skills flexibility, introduce errors, reduce productivity
Constrained IT flexibility due to skills islands (JAVA vs. COBOL)

Multiple infrastructures, vendors, tools, increased costs, less $’s available for new projects
Lack of traceability inhibits end-to-end governance

v Vv v Vv
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Rational Developer for System z Features

= z/OS and unix system services development

» Provides an interactive workstation-based environment to help create, maintain
and reuse applications for traditional processing or for inclusion in an SOA

» Provides easy access to IBM z/OS and UNIX System Services datasets
» Helps create Assembler, COBOL, PL/I, C, and C++ applications via:
= Remote syntax check
= content assist
= visual BMS mapping and JCL generation capabilities
= visual MFS editor
= color coded editing
» Support for
= CICS
= IMS
= Batch
= DB2 and DB2 stored procedures
» Debug and test CICS and IMS system-based code!
» Remote compile generation, build and deployment support

DEMAND BUSINESS'
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Advantages

= z/OS Problem Determination and Deployment Tools that:
» Exploits IBM'’s latest software and processor technology
» Offer wide array of key features and functions
» Can enhance the Application Development Lifecycle
» Provide opportunity for increased user productivity
» Are affordably priced
» Have flexible terms and conditions
» Have no license keys

'ON DEMAND BUSINESS
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For More Information

= z/0OS Problem Determination and Deployment Tools
» www.ibm.com/software/awdtools/deployment
» www.ibm.com/software/awdtools/faultanalyzer
» www.ibm.com/software/awdtools/filemanager
» www.ibm.com/software/awdtools/debugtool
» www.ibm.com/software/awdtools/apa
» www.ibm.com/software/awdtools/apaaa
» www.ibm.com/software/awdtools/workloadsimulator
» www.ibm.com/software/awdtools/migration
» www.ibm.com/software/awdtools/tictoc/
» www.ibm.com/software/awdtools/ispfproductivitytool

ON DEMAND BUSINESS
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For more information

= Help Center
= http://publib.boulder.ibm.com/infocenter/pdthelp/viri/index.jsp

= Redbooks
= www.redbooks.ibm.com/abstracts/sq247372.html

'ON 'DEMAND BUSINESS
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For More Information

= Training
» Services
= Mentor Workshops

» Free Web-based
= Application Performance Analyzer

= Debug Tools Utilities and Advanced Functions

= Fault Analyzer

= File Manager

= Workload Simulator

= 2/0OS Problem Determination and Deployment Tools Can Be
Ordered From Your IBM z/Series Sales Representative

|DEMAND BUSINESS
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IBM PD Tools Product Identification

= Fault Analyzer for z/OS (5655-S15)
= File Manager for z/OS (5655-S14)
= Debug Tool Utilities and Advanced Functions for z/OS (5655-5S16)

= Application Performance Analyzer for z/OS (5697-N63)

- ﬁ%pclgg:ation Performance Analyzer Automation Assistant for z/OS (5799-

= Workload Simulator for z/OS & OS/390 (5655-139)
= Migration Utility (5697-N44)

= Application Time Facility (5697-N42)

= ISPF Productivity Tool (5698-A81)

= Rational Developer for System z

"DEMAND BUSINESS
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